






    
        
            EasePDF
            
                
                    
                        Unlock PDF
                    

                    
                        Compress PDF
                    

                    
                        Merge PDF
                    

                    
                        
                        Tools
                    

                    
                        
                        Pricing
                    

                

                
                   
                         
                           
                         
                        
                            Log in
                            Sign up
                        

                        
                            
                                
                                Loding...
                                
                            

                            
                                	
                                            
                                            
                                            My Account
                                            
                                        
	
                                            
                                            
                                            Help
                                            
                                        
	
                                            
                                            
                                            Log Out
                                            
                                        


                            

                        

                   

                   
                        
                             
                             
                                  
                                       
                                  

                                  
                                        Log in
                                        Sign up
                                  

                            

                        

                        
                            
                                
                            

                            
                                	
                                            
                                            
                                            My Account
                                            
                                        
	
                                            
                                            
                                            Help
                                            
                                        
	
                                            
                                            
                                            Log Out
                                            
                                        


                            

                        

                    

                

            
        

        
            
                                
                    Convert to PDF
                                        
                        
                        Word to PDF
                    
                                        
                        
                        Excel to PDF
                    
                                        
                        
                        PPT to PDF
                    
                                        
                        
                        HTML to PDF
                    
                                    

                                
                    Convert from PDF
                                        
                        
                        PDF to Word
                    
                                        
                        
                        PDF to Excel
                    
                                        
                        
                        PDF to PPT
                    
                                        
                        
                        PDF to HTML
                    
                                    

                                
                    Image to PDF
                                        
                        
                        JPG to PDF
                    
                                        
                        
                        PNG to PDF
                    
                                        
                        
                        GIF to PDF
                    
                                    

                                
                    PDF to Image
                                        
                        
                        PDF to JPG
                    
                                        
                        
                        PDF to PNG
                    
                                    

                                
                    Edit PDF
                                        
                        
                        Edit PDF
                    
                                        
                        
                        Rotate PDF
                    
                                        
                        
                        Add Watermark
                    
                                        
                        
                        Add Page Numbers
                    
                                    

                                
                    Organize PDF
                                        
                        
                        Merge PDF
                    
                                        
                        
                        Split PDF
                    
                                        
                        
                        Compress PDF
                    
                                        
                        
                        Crop PDF
                    
                                        
                        
                        Delete PDF
                    
                                    

                                
                    PDF Security
                                        
                        
                        Unlock PDF
                    
                                        
                        
                        Protect PDF
                    
                                        
                        
                        eSign PDF
                    
                                    

                            

        

    
    
    
        How to Convert RTF to PDF

        October 25, 2019Posted byAshley SamsonPDF ToolsMore Topics

    



    
        
            A Step-by-step Tutorial of How to Convert RTF to PDF

            Comment
        

    

    
        
            
                What is an RTF file? RTF (Rich Text Format) is a cross-platform document format developed by Microsoft Corporation that most word processing software can read and save. It can serve as an exchange format between word processing programs of different manufacturers on different operating systems. On the other hand, PDF (Portable Document Format) is a file format based on a page description language developed by Adobe. The specificity of PDF is to preserve the layout of a document - fonts, images, graphic objects, etc. - as defined by its author, regardless of the software, operating system and computer used to print or view it.
 
Therefore, converting an RTF file to PDF is necessary when we want to exchange and share documents without any format and element loosing. In this post, we'll show you how to convert RTF to PDF by using EasePDF RTF to PDF Online Converter, Adobe Acrobat, PDFMate, etc. Each of these solutions comes with a step-by-step demonstration that you'll pick it up right away.
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Part 1. How to Convert RTF to PDF Online

Using an online RTF to PDF Converter is the best way to do the conversion work because in this way you'll be able to break the device limitation. EasePDF allows you to convert RTF to PDF online, no matter you're on a Mac, Windows or Linux computer, or a tablet and cellphone. EasePDF also supports bulk conversion, which makes multiple files converting much more efficient.

Step 1. Open RTF to PDF Converter on EasePDF homepage.



Step 2. Add your rich text format files. Click on the "Add File(s)" button to access files on your device, choose your target RTF file(s) and it will be uploaded to the server. Or you can open an RTF file from your Google Drive and Dropbox cloud drive.
 


Step 3. Download the converted PDF document. The converter will automatically convert the RTF file you uploaded. When the conversion is done, there will be a download link. Click on the link icon and you can copy it to share with others. Or you can hit the "Download" button to download the file to your local device. You can save it to your Google Drive and Dropbox as well.



Now you've finished converting RTF to PDF. Although PDF format will somehow reduce smaller the original format, for huge file conversion, the converted PDF file might still of big size. In this case, you can refer to a PDF Compressor to reduce file size. To protect the PDF, you can add a password online so that other people can't have access to your file without permission.

Other than online RTF to PDF converter, Google Docs is an excellent and easy choice for you to convert files online. The operating steps are almost the same as this article Change Word to PDF Using Google Docs mentioned.
  
Part 2. How to Convert RTF to PDF On Windows

Microsoft Office is the default program to open a rich text format document on Windows computers. We can easily convert RTF to PDF using the "Save As" function or the "Print to PDF" build-in on Microsoft Office. First of all, you need to open the RTF file you want to convert in Office by double-clicking on the document or choose "Open" on the "File" menu to access your files.

Option 1. Use the "Save As" function

Step 1. Choose "Save As" on the menu.



Step 2. Save RTF as PDF. 

On the saving dialog, enter a name for your PDF file and choose "PDF" on the "Save as type" section. You can choose the converted file quality and size by setting the "Optimize for" option. Choose "Standard (publishing online and printing)" for ha high quality and bigger size PDF, and choose "Minimum size (publishing online)" to have lower quality and smaller size PDF. To go to more advanced settings, you can click on the "Options" tab. Finally, click the "Save" button to save your RTF document as a PDF file.



Option 2. Use the "Print to PDF" build-in

Step1. Go to the "File" menu and select "Print". Or you can simply press the shortcut key "Ctrl + P" on the keyboard.



Step 2. On the printing dialog, choose "Microsoft Print to PDF" as the printer. To set the layout of the converted PDF, hit the "Preference" button to open a new window. In here you can set the orientation and paper size. When you finish all the settings, press the "Print" button.



A saving dialog will pop up. Select a storage destination and type a file name, then press the "Save" button. Now you've had the RTF successfully saved as a PDF.

Part 3. How to Convert RTF to PDF on Mac

RTF is used by default in the Mac OS X TextEdit editor, in Windows WordPad, and the Ted word processor, running under Unix-like systems. On Mac computers, we can use TextEdit editor to easily convert an RTF file to PDF.

Step 1. Open the RTF file on Mac. TextEdit should be the default application to open an RTF file when your Mac computer doesn't have Microsoft Word program or other Word alike software installed. If not, put your mouse on the RTF file and right-click on it, then choose "TextEdit" to open the file.



Step 2. Go to the "File" menu on TextEdit top toolbar, select the "Export As PDF" option on the drop-down menu.



Step 3. On the newly opened dialog, enter a file name for the converted PDF file, choose a location on your Mac computer to save it. Click the "Show Details" button and the program will show a setting area. You can choose paper size and change page orientation here. If you would like to include the header and footer of the original RTF, just tick the "Print header and footer" option. 

And we suggest you select the "Rewrap contents to fit page" option, just to make sure the converted PDF will preserve the best layout. When you finish all these settings, click the "Save" button and TextEdit will save your RTF to PDF right away.



Bonus Tip: No matter you're using Mac or Windows, you can always use PDFelement as an alternative to convert RTF to PDF. PDFelement is a professional and practical PDF tool that helps users to edit, convert, merge, split, sign PDF documents with OCR support.


    Download
    Download


Part 4. Convert RTF to PDF On iPhone & iPad

There are many apps on Apple store that support converting RTF to PDF, Rich Text & File Manager is a representative. The Rich Text & File Manager app is an effective application for writing rich text and converting RTF to PDF, Images, HTML and so on. Its simple UI design allows you to navigate fast and get the converting task done within minutes.
 


Step 1. Open your RTF file on Rich Text & File Manager. This app can access files from Box, Dropbox, Google Drive, and Microsoft OneDrive.

Step 2. Tab the "Convert to PDF" button on the screen, the app will start the conversion.

Step 3. Save converted files to local storage or cloud drives. You can also email the converted files.

Part 5. How to Convert RTF to PDF on Android

RTF File to PDF is a lightweight Android app designed for converting RTF file from your internal and external SD card, and even from your Dropbox to PDF effortlessly.

Step 1. Install and open RTF File to PDF app. Go to Google Play app store and search for RTF File to PDF, install it to your Android phone, then open the app.



Step 2. Upload your RTF file.
 
If the RTF file you want to convert is in your Android phone's device, select the "Upload & Convert File" mode. Click the "Upload File" button and the app will navigate you to the storage location. Select a file that has a .rtf extension name. Next, choose a page size for your converted PDF. You can choose page sizes from A4, A3, A5, Legal and Letter. Then choose the page orientation from portrait and landscape. Now click the "Convert File" button to start the conversion.



Step 3. Download the created PDF.

The app will convert your RTF file to PDF immediately after you hit the convert button, you can see the progress bar in your interface. The processing time mostly depends on the file size, just wait a few minutes. A download link will appear when the conversion is done. You can save this converted PDF to your Dropbox or directly open it on your device by downloading it first.



You can also convert RTF files from your Dropbox, just choose the "Convert a Dropbox File" mode when on step 1. The app will access to Dropbox for you to choose documents. And the rest steps are all the same. No matter you're an iOS or Android user, if you don't want to download any app on your cellphone, you can always use EasePDF Online RTF to PDF Converter as an alternative.

Part 6. How to convert RTF to Doc

Converting RTF to a .Doc Word document is much easier than converting to PDF. On most applications we mentioned above that can open an RTF file, like Google Docs, TextEdit (Mac), Microsoft Word, and WPS, just choose the "Save As" or "Export As" option, and select "Microsoft Word" as the saving format. That's it, as simple as you can imagine.
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